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Graphing and Curve Analysis Using Microsoft Excel 
Fall 2024 

The following instructions guide you through the process of using Microsoft Excel to perform simple 
calculations, creating an x-y scatter plot (called a “chart” in Excel) from a set of data, and having Excel calculate 
and draw a line that best fits your data (called a “trendline” in Excel). The last page of this document details the 
analysis procedure you will use on your finished graph. Many of the experiments performed this semester use these 
graphing and analysis techniques, so it is important that you understand them.  

IMPORTANT:  

• The instructions to enter data into a spreadsheet and create a graph follow below.  
• When working on the “Graphing and Curve Analysis…” exercise (Lab 1b), you will use a spreadsheet 

containing measured data of position and time for an object moving at a constant velocity.  
o Download the Excel Graphing Exercise 2024 from the Canvas assignment Lab 1b. Save this 

spreadsheet to your OneDrive to make it easy to find. Open the spreadsheet in Excel. 
o After opening this sample data, read step #1 below and then skip to step #2. Note that you will 

start with step #1 when entering your own experimental data.  
• Be sure to have a copy of these instructions available each week until you have mastered the procedure. 

Entering Data and Performing Calculations 

1. Excel is pretty picky about the arrangement of data to be plotted, so when you set up columns for your data 
in the spreadsheet, make sure that the values you will plot along the horizontal (x) axis appear to the left of 
the values to be plotted along the vertical (y) axis. Include a title for each column, including the units; 
this will ensure that you are plotting your data correctly! Boldface and center the column titles so that 
they stand out and be sure to save your spreadsheet since it will be submitted to your instructor.  

2. If you are working on Lab 1b, you see data that measured the amount of time (t) that it takes a cart to travel 
to position 2 (x2) on a track. The cart always starts at position x1 = 10.0 cm, and the distance the cart travels, 
L = x2 – x1 (a sketch appears at the bottom of the spreadsheet). First, let’s enter the correct value for 
position x1 in the table. 

• Pro tip: Instead of typing ‘10’ in column x1 twenty-one times, 
simply type 10 in cell B2. Since there is already an existing column 
of numbers (the t values), you can double-click on the handle in the 
lower right corner of the cell, and that will copy this value down 
the correct number of times (Figure 1). 

3. Next, we need to calculate L, the distance the cart travels. Note that 
Excel uses letters (A, B, C, …) to designate columns, and numbers to designate rows. Since L = x2 – x1, we 
need to create an equation to subtract the values in column B from those in column C. Enter the following 
equation in cell D2; note that an equation always starts with an equal sign: 

= C2 – B2 

• Pro tip: When creating your equation, click each cell that will be used in the calculation instead of 
typing the cell address. So, for the equation above you would type ‘=’, click cell C2, type ‘–’, and then 
click cell B2. 

4. Copy the equation down the rest of the column. You can use the tip shown in Figure 1, or simply grab the 
handle in the lower right corner of cell D2 and drag it down as far as needed. 

  

Figure 1 – Copy cell contents 
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Creating a Graph 

5. Now that our data table is complete, we can select the data to be plotted. Since we are using Excel for our 
calculations, the data we will plot may not be in adjacent columns. We wish to create a distance vs. time 
graph from our data, so distance will be plotted along the vertical axis and time along the horizontal axis, so 
we need to select these two columns. 

• First, select the time column by clicking on the column label, A. 

• Next, we need to select the distance column while keeping the time column selected, but we don’t 
want to select either x column. You need to hold down a modifier key while clicking, and that differs 
depending on whether you’re using a Windows or Macintosh computer: 

o Windows: hold the Control (Ctrl) key down, and click on the column label, D. 
o Macintosh: hold the Command (⌘) key down, and click on the column label, D. 

6. With the two columns selected, click the Insert tab. In the Charts group, click the Scatter (X, Y) button, 
then choose “Scatter” (Figure 2, highlighted). A graph will appear in your worksheet. 

7. The graph is inserted as a new object on the worksheet, which 
allows you to see the data and the graph at the same time. This is 
useful when creating the graph as you collect your data; you can 
check that the data points fall along the shape of the expected 
function. Later you will move the graph so that it is easier to read 
and analyze. 

Please, do not remove the grid lines from your graph! 
8. You will next add axis labels as follows: Select the graph, which 

should switch you to the Chart Design tab. Click the Add Chart 
Element button, then Axis Titles and then Primary Horizontal. 
Repeat these steps, this time choosing Primary Vertical. Double-
click each “Axis Title” and include an appropriate label; you must 
include units on the axis labels! 

9. Double-click the title region and enter a title for your graph. “L vs. t for a moving cart” is sufficient. You do 
not need to include units in the title.  

Adding More Data to the Graph 

10. When performing an experiment, you may decide that you need to add some extra data points after 
examining your graph. Let’s add one more data point to your data table: enter 105 to the t column, and 
102.3 to the x2 column. Complete the entries for the x1 and D columns. 

11. Click the graph, and you will see the plotted data highlighted in 
the table. Click and drag downward on one of the handles that 
appear at the bottom of either selected column until the new data 
is selected (Figure 3). Let go of the handle and the new data 
point will appear on the graph. 

12. Corrections or additions to the data can now be made if needed. 
Simply change a number or delete a bad data point and the graph will update automatically. 

Adding the Curve-Fit Function 

13. Now that you have created your graph, you need to add a curve-fit line, called a trendline in Excel. Select 
any data point with a right-click (Windows) or control-click (Macintosh) and choose “Add Trendline...”; a 
linear fit is applied to your data (even though this may not be the correct function for your data!) The 

Figure 2 – Creating a scatter plot 

Figure 3 – Adding data to a graph 
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“Format Trendline” panel appears to the right of your graph containing six curve-fit functions, also known 
as regressions. 

Excel will determine which of the six can be used for your data (but it doesn’t pick the correct function for 
you!) We might use four of these regressions in lab: “Exponential” (y = aebx); “Linear” (y = mx + b); 
“Polynomial” (of 2nd order: y = ax2 + bx + c); or “Power” (y = axb).  

14. Select the function that best fits your data. Note that when performing an actual experiment, you will 
generally know the function that you expect to fit your data. You will be guessing at the best fit when doing 
the “Graphing and Curve Analysis…” exercise. If you pick the wrong regression and have closed the 
“Format Trendline” window, right-click or control-click on the trendline (not a data point) and choose 
Format Trendline again. 

• Important note: If you pick a function which cannot be applied to the selected data set, Excel will 
remove the trendline, and the dialog box will switch from “Format Trendline” to “Format Chart Area”. 
Close this window and add the trendline again. 

15. Next, you will ALWAYS put a check in the box next to Display Equation on Chart. This will display the 
appropriate equation for the line chosen. Excel calculates the values of the appropriate coefficients a, b, c, 
and m. You should note that more significant figures might be presented than are dictated by the accuracy 
of your measurements. It is from these coefficient values that you will be performing your analysis.  

• Note #1: The default font size for the equation box is 9-point, a very small size that your aging lab 
instructor will find difficult to read. Increase the font size by selecting the equation box, clicking 
the Home tab and changing the font size to 14. Move the equation so that it does not obscure the 
line or any data points. Thank you. 

• Note #2: You do not need to check Display R-squared value on chart. The value of R2 will always 
be very close to 1 in our experiments, so it does not provide us with any useful information. 

Viewing and Printing the Graph 

16. A full-sized graph is easier to analyze (bad measurements or interesting trends are more readily noticed), 
and the graph will look better if it needs to be printed. Move the graph to a new worksheet as follows:  
select the graph, which should switch the toolbar to Chart Design. Next click the Move Chart button, then 
click the button next to New Sheet, and then OK. The full-size graph now appears on a new worksheet 
(called Chart1) in front of the sheet that contained your data. 

17. The worksheet containing the graph should appear after the sheet with your data, so click & drag the 
Chart1 tab to the right, after the data sheet. 

18. Occasionally, you may be asked to print your graph, so you will want your name and those of your partners 
to print on the graph to distinguish it from the others in the printer since everyone in the lab will collect 
similar data for a particular experiment. An elegant way of adding your names, the date and the experiment 
title to your graph is to put them in the header of the page. Again, the way you get to these options is 
slightly different on Windows and Macintosh: 

• Windows: Click the File tab, and then Print. Click Page Setup... (below the “Settings”, center-left on 
the window), and then the Header/Footer tab.  

• Macintosh: Click the File menu, and then Page Setup, and then the Header/Footer tab.  

19. Next click the Custom Header... button and type your names in the “Left Section” box. Put the experiment 
title in the “Center Section” box.  

20. Insert the current date in the “Right Section” box by clicking the “Date” button 
(Figure 4). This will add &[Date] to the right section of the header and will print 
the current date on the graph.  

21. Click OK twice to return to the print window. If the graph is to your liking, check that you are printing to 
the correct printer, set the number of copies and click the Print button.  

Figure 4 – Date Button 
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Analyzing the Graph 

Now you will analyze your graph to determine the results of your experiment. These results will come 
from the values calculated in your curve-fit function. How will you determine which results give you the 
quantities that you are seeking? 

The first step of our analysis with graphed data will always be to look at the curve-fit function and see 
how it compares to the expected theory for the experiment. Today you should have chosen the Linear fit for 
this data (if you have previously read these instructions, you should know that already!) The form of a 
linear function is y = (slope) x + y-intercept = m x + b. 

Next, you should look at your graph to determine what x and y represent. Today you plotted time, t on the 
horizontal (x) axis and distance, L on the vertical (y) axis. Now we can substitute t for x, and L for y so that 
our equation becomes: 

 
b
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We see that we have two unknown constants: the slope, m and the y-intercept, b. Next, we need to look at 
the relationship between distance and time. The definition of velocity gives us L

tv = ; we can algebraically 
rearrange the velocity definition so that it follows the pattern of a linear function, as shown below: 
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This shows us that the slope of the line equals the velocity. What do you think is the y-intercept (the 
value of y when x = 0) and its units in this case?  

22. What velocity do you get from your linear graph of distance vs. time? Write the value (and the appropriate 
units!) on your printed graph. 

This is how we will analyze graphed data in all future experiments, whether the data is linear or non-
linear (as you will see next week.) Note that in today’s example, the expected intercept, b, is zero, but the 
graph shows that it has a small value. In future experiments, this may be an indication of an error, or the 
result of some initial conditions of your measurements, or perhaps something interesting that occurred 
while performing your experiment. 
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